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SECTION 1
INTRODUCTION

1.1 PURPOSE

 PatentIn 3.0 facilitates the creation of patent applications for genetic sequences.  It accepts data
about the patent application, validates the data, and creates a sequence listing file for submission.
This manual describes how to use  PatentIn 3.0.

1.2 CONVENTIONS

Consistent visual cues and standard keyboard operations are used throughout this manual.  These
conventions are listed in Table 1-1 below.

Table 1-1:  Document Conventions

Notation Represents Example

� Process the command with a mouse
action.

� Select Open from the file menu.

� Process the command with the
keyboard.

� Enter changes into the Edit field.

Bold type Name of a function, file, menu item,
or programming construct.

� Click on Exit.

ii An informative message to the user. ii  NOTE:  These fields are mandatory.

1.3 OVERVIEW

PatentIn 3.0 is a computer program designed to expedite the preparation of United States Patent
and Trademark Office (USPTO) patent applications containing nucleic acid and polypeptide
sequences.

PatentIn 3.0 complies with all format requirements specified in WIPO ST.25 and the related U.S.
final rule, "Requirements for Patent Applications Containing Nucleotide Sequence and/or Amino
Acid Disclosures."  It runs on Windows 95, Windows 98, and on Windows NT. Screen displays
in Spanish, French, and German will become available in a later release.

For ease of use, the design follows standard Windows user interface conventions.

PatentIn 3.0 includes the following tools:

•  A Sequence Editor

 The primary tool within PatentIn 3.0 is the sequence editor, which enables you to enter
and modify both nucleic acid and protein sequence listings, as well as import sequence
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listing files created by another editor or word processor (provided they are stored as
ASCII text files).

 When working in PatentIn 3.0 you may enter data in any order, and also add, remove, or
revise sequence listing data at any time. You may also save a partially completed
application and finish it at a later time.

•  A Sequence Generator

After you have entered all the data necessary for your patent application, PatentIn 3.0
enables you to generate your application. The application consists of a computer-readable
file containing a sequence listing file, which is prepared in accordance with the WIPO
ST.25 standard.
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SECTION 2
SYSTEM REQUIREMENTS AND PATENTIN 3.0 ACCESS

2.1 SYSTEM REQUIREMENTS

PatentIn 3.0 is a self-contained application that can be downloaded from the United States Patent
and Trademark Office (USPTO) web site. It operates in a Windows 95/98/NT environment. A
minimum of 64 MB of memory is recommended. Additional memory may be required for large
patent applications. Very large projects, projects with 100,000 sequences or a sequences
approaching 1M, will need a minimum of 128 MB of memory. The disk space required to install
PatentIn 3.0 is 2 MB. Additional disk space is required to store project files and sequence listing
files.

For PatentIn to work correctly, the “TMP” environment variable must point to a valid directory,
and the “PATH” environment variable must include the DOS backup command in the path.
Most Windows installations will meet these requirements.

ii   Special Note for users with very large sequences and large numbers of sequences:PTO has
located a  viewers that really works for very large text files.  A 60 day evaluation version is
downloadable at www.fileviewer.com <http://www.fileviewer.com> .  The viewer is named "V"
and version 2000 SR-1.  It was tested with 60MB and 120MB files and “worked great.” It should
manage files of just about any size.  It was tested on a laptop with Win98. (LocalAdmin may be
required for installation)

2.2 PATENTIN 3.0 ACCESS

PatentIn 3.0 can be downloaded onto your personal computer. The program can be downloaded
from the USPTO web page. The Universal Resource Locator (URL) from which the PatentIn 3.0
application can be obtained is: http://www.uspto.gov/web/offices/pac/patin/patentin.htm. Follow
the instructions found on the Web page to download PatentIn 3.0 and install it on your PC. Upon
completing the installation, an icon will be placed on your desktop. Access to the PatentIn 3.0
application program occurs when you double click on the PatentIn 3.0 icon.
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SECTION 3
GETTING STARTED

3.1 PATENTIN 3.0 SEQUENCE

When you first access PatentIn 3.0 by double clicking on the PatentIn 3.0 icon on your desktop,
you have immediate access to the PatentIn 3.0 Sequence Screen.

The PatentIn 3.0 Sequence Screen  (Figure 3-1)is the main screen.

Figure 3-1: PatentIn 3.0 Sequence Screen
The PatentIn 3.0 Sequence Screen (Figure 3-1) provides the user with five drop down menus.
Three of which provide access to the real-time system interface. They are Project, Application
Steps, and Help. The remaining two drop down menus, Edit and View, are general Microsoft®

Windows type menus. The user may select any one of the three drop-down menus when a project
is begun. PatentIn 3.0 presents an empty project upon startup. The user can open an existing
project with the PatentIn 3.0 Project Menu (Figure 3-2).
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3.2 PATENTIN 3.0 PROJECT MENU

The PatentIn 3.0 Project Menu (Figure 3-2) enables you to create and save a project. Selecting
“Save” displays the Save As  (Figure 3-3) where a new project is given a name and is saved.
Selecting “Open” displays the Open Screen (Figure 3-4) where the user can select a previously
saved project to open. The “ Exit PatentIn 3.0” selection closes the application. Menu items that
require a project to be opened, or an output file to be present, are grayed out until those
conditions are met.

The PatentIn 3.0 Project Menu (Figure 3-2) selections are shown below. The user will see a list
of selectable Menu Items under the Project menu and the active project name on the upper left-
hand corner of the screen. In this case Untitled is shown as no project has yet been opened or
saved.

Figure 3-2:  PatentIn 3.0 Project Menu
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3.3 CREATING AND SAVING A NEW PROJECT

To create and save a new project:
Begin building the new file upon opening the main screen, PatentIn 3.0 Sequence Screen, or:

1. � Select New from the Project menu. This clears the all of the current project information.
2. � Select Save from the Project menu. The Save As Screen (Figure 3-3) appears.
3. � Enter the new file name into the File Name dialog box.
4. � Click on Save to create the new file.
5. The name for the new project will be displayed on the upper left-hand corner of the screen.

Figure 3-3: Save As Screen
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3.4 OPENING A PROJECT

To open an existing project:
1. Select Open from the Project menu. The Open Screen (Figure 3-4) appears.
2. Open the directory where the file is located.
3. Double-click on the file name to open the file.
4. You are returned to the main screen. The name of the opened project is displayed in the

upper left-hand corner of the screen, indicating the project is active.

Figure 3-4: Open Screen

ii   SPECIAL NOTE FOR USERS WITH VERY LARGE SEQUENCES AND LARGE NUMBERS OF SEQUENCES: it takes some
time for a large project to clear from memory. This is especially noticed when immediately
reopening the project.
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3.5 SAVING A PROJECT

To save a Project:

When a project is saved for the first time, the user is automatically prompted to enter a file name.

1. � Select Save from the Project menu. The Save As Screen  (Figure 3-5) will appear if the
project has not previously been named. Otherwise, the project will be saved as the previously
opened or created name.

2. � Select the directory where you want to save the file.

3. � Type the new file name in the File Name dialog box.

4. � Click on the Save button to save the project with the new file name.

5. PatentIn 3.0 returns you to the main screen. The new name is displayed in the upper left-hand
corner of the screen, indicating that the project is active.

To save under a different file name:
1. � Select Save As from the Project menu. The Save As Screen (Figure 3-5) will appear.
2. � Select the directory where you want to save the file.
3. � Type the new file name in the File Name dialog box.
4. � Click on the Save button to save the project with the new file name.
5. PatentIn 3.0 returns you to the main screen. The new name is displayed in the upper left-hand

corner of the screen, indicating that the project is active.

Figure 3-5: Save As Screen
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3.6 VIEWING A WORK FILE

The user can view the current work in progress by creating a work file. This work file provides a
vehicle for the user to view the data for the entire project in a single place instead of reviewing
each individual screen.

To see the Work File:
From the Project Menu, � select View/Print Work in Progress.

ii   Note: This work file was built by selecting Create Work File.

3.7 VIEWING WORK IN PROGRESS

PatentIn 3.0 provides the user with an on-screen display of the Patent Application with the View
Work in Progress Window (Figure 3-6).

Figure 3-6: View Work in Progress Window
To view the current patent application:
1. From the Project menu, � select View Work in Progress.
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2. To print the error report, � click on the File then Print.
3. To exit the screen, � click on File Exit.

ii   Note: This work file was built from the sequence generation.

3.8 VIEW A SEQUENCE LISTING

PatentIn 3.0 provides the user with an on-screen of the Sequence Listing with the View Sequence
Listing Window(Figure 3-7).

Figure 3-7: View Sequence Listing Window
To view the sequence listing:
1. From the Project menu, � select View Sequence Listing.
2. To print the error report, � click on the File then Print.
3. To exit the screen, � click on File then Exit.

ii   Note: The sequence must first be generated.
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3.9 VIEWING ERROR REPORTS

PatentIn 3.0 provides the user with an on-screen Error Report with the View Error Report
Window(Figure 3-8), if one exists, for the opened project.

Figure 3-8: View Error Report  Window
To view an error report:
1. From the Project menu, � select View Error Report.
2. To print the error report, � click on the File then Print.
3. To exit the screen, � click on File then Exit.
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3.10 EXIT PATENTIN 3.0
If the project does not have a current save the user will be queried with the Exit PatentIn 3.0
Screen(Figure 3-9) about whether the project should be saved:

Figure 3-9:  Exit PatentIn 3.0 Screen

3.11 HOW TO USE ONLINE HELP

On-line help is available for the PatentIn 3.0 application screens. PatentIn 3.0 Help Screen
(Figure 3-10), presents a typical help screen. Pressing the help button on the active screen
accesses the on-line help screen.

Figure 3-10: PatentIn 3.0 Help Screen
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1. To exit the Help screen, � click on the OK button.

3.12 PATENTIN 3.0 MESSAGE DIALOG

The PatentIn 3.0 Message Dialog Screen (Figure 3-11) is a screen that appears if one of the
action buttons (Add, for example, described in Section 4, Project and Applicant Data) is pressed
and an entry has not been made to the input area of the screen.

Figure 3-11: PatentIn 3.0 Message Dialog Screen
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SECTION 4
PROJECT AND APPLICANT DATA

Once the Sequence Listing data file has been created, the user can add information to the
application.

4.1 PATENTIN 3.0 APPLICATION STEPS MENU

The Application Steps Menu (Figure 4-1) selections are available when a project is begun, has
been created or selected. The name is visible at the upper left bottom corner of the screen. In this
example the project has opened a previously existing file, Demo is shown for the project name.

Figure 4-1: PatentIn 3.0 Application Steps Menu
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4.2 PROJECT DATA

The PatentIn 3.0 Project Data Screen (Figure 4-2) provides the user with input fields to establish
the identifying information for the new invention. This information is the key that establishes the
title of the invention and the filing date.

ii   Note:  The mandatory information fields are in red.

Figure 4-2: PatentIn 3.0 Project Data Screen
To enter Project Data:
1. � Enter the Title of the Invention. This information is mandatory.
2. � Enter the Current Application Number, if one exists. If an application is entered the

current filing date becomes mandatory.
3. � Enter the Current Filing Date. The date format is numeric: YYYY-MM-DD.
4. � Enter the Application File Reference.
5. To validate the information entered, � click on Validate.
6. To save the information, � click on the Save Project button.

4.3 PRIOR APPLICATION INFORMATION

Entering information about prior applications is optional. This information will help the patent
examiner process the claim. Any number of prior applications may be included on the form.
They will be displayed in the table in the order entered and may be selected for editing or
deletion PatentIn 3.0 Prior Application Information Screen).
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Figure 4-3: PatentIn 3.0 Prior Application Information Screen
To enter information about a Prior Application:
1. � Enter the Prior Application Number. If a prior application number is entered then the

prior application date becomes mandatory.
2. � Enter the Prior Application Filing Date. The date format is numeric: YYYY-MM-DD.
3. To clear the information in the Edit Prior Application area, � click on Clear.
4. To insert the information to the list, � select the item you want the information to follow, �

enter the  Prior Application Number and the Prior Application Filing Date, then� click
on the Insert button.

5. To replace an entry from the list, � select the item, � enter the Prior Application Number
and the Prior Application Filing Date, then � click Replace.

6. To delete an entry from the list, � select the item from the list, and then � click on the
Delete button.

7. To validate the information entered, � click on Validate. Data entered in the table (Insert) is
then validated. Information in the edit area, that has not yet been inserted, is not validated.

8. To save the information, � click on the Save Project button.
9. To validate and close, � click on the OK button.
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4.4 APPLICANT DATA

The Applicant Data Screen (Figure 4-4) allows the user to input screen for an Individual or
Organizational applicant. Select Applicant Data from the Application Steps menu, then select
either Individual or Organization from the next menu. If Individual is selected, the PatentIn 3.0
Individual Applicant Screen (Figure 4-5) will appear. If Organization is selected, the PatentIn 3.0
Organization Applicant Screen (Figure 4-6) will appear.

Figure 4-4: Applicant Data Screen

4.4.1 Individual Applicant

The PatentIn 3.0 Individual Applicant Screen (Figure 4-5) allows the user to enter information
about an individual applicant.

ii   Note:  The field names in red (Last Name and First Name) are mandatory information.
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Figure 4-5: PatentIn 3.0 Individual Applicant Screen
To enter information about an Individual Applicant:
1. From the Application Steps menu, � Select Applicant Data, then � Select Individual.
2. � Enter the User’s Last Name (surname).
3. � Enter any Suffix the user has on his/her name (e.g., Jr., III).
4. � Enter the User’s First Name.
5. � Enter the User’s Middle Initial.
6. � Enter the User’s Street Address, City, State/Province, Country, Zip/Postal Code, Phone

Number, Fax Number, and Electronic Mail Address.
7. To clear the information about the Individual Applicant � click on Clear.
8. To insert the information to the list, � select the item you want the information to follow, �

enter the Edit Individual Applicant information, then� click on the Insert button.
9. To replace an entry from the list, � select the item, � enter the Edit Individual Applicant

information, and then � click Replace.
10. To delete an entry from the list, � select the item from the list, and then � click on the

Delete button.
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11. To validate the information entered, � click on Validate. Data entered in the table (Insert) is
then validated. Information in the edit area, that has yet been inserted, is not validated.

12. To validate and close, � click on the OK button.
13. To add another applicant to the list repeat Steps 1-12.

4.4.2 PatentIn 3.0 Organization Applicant

The PatentIn 3.0 Organization Applicant Screen (Figure 4-6) allows the user to enter information
about an organization applicant.

Figure 4-6: PatentIn 3.0 Organization Applicant Screen
To enter information about an Organization Applicant:
1. From the Applicant Steps menu, � Select Applicant Data, then � Select Organization.
2. Enter the Organization’s Name.
3. Enter the Organization’s Street Address, City, State/Province, Country, Zip/Postal Code,

Phone Number, Fax Number, and Electronic Mail Address.
4. To clear the information about the Edit Organization Applicant portion of the screen, � click

on Clear.
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5. To insert the information to the list, � select the item you want the information to follow, �
enter the Edit Organization Applicant information, then� click on the Insert button.

6. To replace an entry from the list, � select the item, � enter the Edit Organization
Applicant information, and then � click Replace.

7. To delete an entry from the list, � select the item from the list, and then � click on the
Delete button.

8. To validate the information entered, � click on Validate. Data entered in the table (Insert) is
then validated. Information in the edit area, that has not yet been inserted, is not validated.

9. Repeat steps 2 through 9 until all applicant information has been included.
10. To validate and close, � click on the OK button.
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SECTION 5
SEQUENCE DATA

5.1 SEQUENCE

The Sequence Screen (Figure 5-1) you to create and modify sequences. You can create and edit
custom codons and custom organism names from this screen. It also provides a search function
where a genetic sequence may be entered and searched for in the files on his workstation. The
user will access this screen immediately after PatentIn 3.0 is started or by selecting Create User
Work File from the Project menu.

Figure 5-1: Sequence Screen
To select a sequence for editing:
� Select the sequence name from the list of sequences.
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The following sequence characteristics are displayed:
Cursor Pos Shows the current cursor position.

String LengthShows the length of the sequence string on the line.

Line Number Indicates the line number of the cursor relative to the beginning of the string.

5.1.1 Selecting a Standard Organism
This screen enables the user to select an organism name from common organisms. Included in its
capabilities is an attempt matches on partially input names.

Figure 5-2: Selecting a Sequence Number Screen

To select an Organism Name:
1. � Click on the Standard button.
2. Begin � entering characters for the organism you are looking for.
3. � Click on the OK button to enter the selected organism name.



5-4

5.1.2 Searching for a Sequence

To search for a specific sequence:
1. � Enter a particular substring (a feature, for example) in the edit field below the Search for

button.
2. � Click on the Search button. The cursor will move the first instance of that sub-sequence.

ii  NOTE: Each Search is limited/truncated to 60 characters.

5.1.3 Clearing the Screen
1.  To clear the entire screen, � Click on the Clear button (Figure 5-1).

5.2 ADDING A SEQUENCE

The Add button on the Sequence Screen (Figure 5-1) provides a means to enter a sequence name
and to select a sequence type from a list of radio buttons (Figure 5-3).

Figure 5-3: PatentIn 3.0 Add A Sequence Screen
To add a sequence:
1. From the Sequence screen,� select the Add button. The PatentIn 3.0 Add A Sequence

Screen appears.
2. � Enter the sequence name into the dialog box.

3. � Select the sequence type by clicking on the ◉ radio button next to the appropriate
sequence type.
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You can now enter sequence strings in the edit field at the bottom of the screen.  If you are using
Windows 95, a maximum of 64K characters will display in the field. In Windows NT and 98, the
upper limit is over 1 million sequence characters.

You can work around these limitations by using import files, rather than the Sequence Editor, to
create and edit sequences.

5.2.1 Importing a Sequence

The Import button on the Sequence screen (Figure 5-1) provides a means to import a sequence
name and then to select an import source from two radio buttons.

Figure 5-4: Import Sequence(s) Screen
1. To use a sequence from a text file, � click on the Import Sequence button, then � click on

the From File radio button. (See 5.2.2)
2. To use a sequence from another project, � click on the Import Sequence button, then �

click on the From Project radio button.
3. A Browse button is provided to assist the user in providing the file folder and file name.

ii  NOTE: For the Protein/3 selection, the data must be imported from a text file that
contains only amino acid abbreviated names as shown in Appendix D: Exchange Nucleotide
Characters and Amino Characters, PRT/3 Column. The PRT/3 strings are converted to PRT/1
characters for subsequent use in the Sequence Editor.

5.2.2 Format for Sequence Data Files to be Imported by PatentIn 3.0
A sequence file is an ASCII text file containing one or more sequences. Each sequence begins
with a header having the following format. The header must be the first non-blank text on its
line.
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5.2.2.1 Sequence Header
The entire header must be on a single line (Table 5-1).

<SequenceName;SequenceType;OrganismName>

Table 5-1:  Header for Sequence

SequenceName the name of the sequence

SequenceType one of the following:

•  DNA

•  RNA

•  DNA/RNA

•  Protein/1

•  Protein/3

OrganismName the name of the organism, and is optional. If it
is omitted, the header looks like:
<SequenceName;SequenceType;>.

5.2.2.2 Sequence Data
The sequence data begin on the line following the header. The sequence data are a string of
letters appropriate to the sequence type. The sequence data may span multiple lines. Sequence
data may not contain spaces. A space signifies the end of the sequence data.

The sequence data are terminated by one or more spaces, or by the start of the next header. There
may be one or more empty lines between the end of a sequence and the start of the next.

5.2.3 Sequence Data Files to be Imported by PatentIn 3.0
A two-sequence file might look like this Sample ASCII Sequence Data (Figure 5-5):

< First Sequence;DNA;Abies alba>
ttttcttattgtttctcctactgcttatcataatgattgtcgtagtggcttcctcatcgt
ctcccccaccgcctaccacaacgactgccgcagcggattactaatagtatcaccaacagc
ataacaaaaagaatgacgaagagggttgctgatggtgtcgccgacggcgtagcagaagga
gtggcggagggg

< Second Sequence;RNA; >
uuuucuuauuguuucuccuacugcuuaucauaaugauugucguaguggcuuccucaucgu
cucccccaccgccuaccacaacgacugccgcagcggauuacuaauaguaucaccaacagc
auaacaaaaagaaugacgaagaggguugcugauggugucgccgacggcguagcagaagga
guggcggagggg

Figure 5-5: Sample ASCII Sequence Data
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5.3 COPYING A SEQUENCE

PatentIn uses standard Windows type edit features.

To copy a sequence:
1. � Highlight the sequence to be copied.
2. � Click on the Edit menu then � Click Copy.  (Figure 5-6)

Figure 5-6:  Edit Menu

5.4 PASTING A SEQUENCE

To paste a sequence:
1. Position the cursor where the copied material is to be inserted.
2. � Click on the Edit then � Click Paste.

5.5 DELETING A SEQUENCE

To delete a sequence:
1. � Click on the Delete button.
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5.6 RESTORING A SEQUENCE

When a sequence has been deleted it can be restored until the current project update is
terminated.

To restore a sequence:
1. � Click on the Restore button on the main screen. The Sequence Recovery Screen (Figure

5-7) appears.
2. � Select the sequence(s) to be restored.
3. � Click on the Restore button.

Figure 5-7:  Sequence Recovery Screen

5.7 REORDERING SEQUENCES

ThePatentIn 3.0 Reorder Sequences Screen (Figure 5-8) provides the user with the means to
compare the current sequence order and the new sequence order. The Current Sequence Order
displays the sequences in the order that the sequences were entered into the application. The New
Sequence Order displays the sequences in the order that the user specifies by using the Add and
Remove buttons.
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Figure 5-8: PatentIn 3.0 Reorder Sequences Screen
To reorder sequences:
1. � Select the sequences from the menu on the left-hand side.
2. � Click on the row the sequence will follow.
3. Repeat steps 1-2 until the sequences are in the desired order.

5.8 VALIDATING SEQUENCES

To Validate the Sequences:
1. On the Sequence Screen (Figure 5-1), � Click on the Validate button. A message screen

will inform you if there was an error, otherwise Validation OK will appear on the status bar.

ii NOTE: FOR THE SEQUENCE DATA, VALIDATION IS DONE FOR THE SELECTED SEQUENCE NAME.

5.9 SAVING SEQUENCES

To Save a Sequence:
1. On the Sequence Screen (Figure 5-1), � Click on the Save button. Your work will be saved

in its current state.
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5.10 ADDING CUSTOM CODONS

The PatentIn 3.0 Custom Codon Input Screen (Figure 5-9) provides the means to add Custom
Codons to the list of standard codons on the user workstation. This screen is accessed from the
Application Steps menu (Figure 4-1) by selecting the Define Custom Codon item.

Figure 5-9:  PatentIn 3.0 Custom Codon Input Screen
To add a Custom Codon:
1. � Select the Define Custom Codon item from the Application Steps menu (Figure 4-1).
2. � Select an Amino Acid from the drop-down list (Figure 5-10).
3. � Enter the Custom Codon.
4. � Click on the Insert button.
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To delete a Custom Codon:
1. � Click on the Custom Codon in the list.
2. � Click on the Delete button.

Figure 5-10: Amino Acid Drop Down List Screen

5.11 ADDING A CUSTOM ORGANISM

The PatentIn 3.0 Custom Organism Input Screen (Figure 5-11) provides the means to add a
Custom organism to the list of custom organisms. It also enables you to select a custom organism
to enter on the Sequence screen. This screen is accessed from the Sequence screen (Figure 5-1)
by selecting the Custom button. The user enters the custom organism into the screen, and then
can manipulate the list by adding or deleting organisms.
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Figure 5-11: PatentIn 3.0 Custom Organism Input Screen
To add a Custom Organism:
1. � Select the Custom button from the Sequence screen.
2. � Enter the Custom Organism.
3. � Click on the Insert button.
To delete a Custom Organism:
1. � Click on the Custom Organism in the list.
2. � Click on the Delete button.
To replace a Custom Organism:
1. � Click on the Custom Organism in the list.
2. � Enter the Custom Organism.
3. � Click on the Replace button.
To enter a Custom Organism on the Sequence screen:
1. � Select the Organism so that the name appears in the “Please enter a custom organism

name:” box.
2. � Click on the OK button.
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SECTION 6
FEATURE DATA

6.1 SEQUENCE FEATURES

The PatentIn 3.0 Features Screen ( Figure 6-1) enables you to create and modify features
pertaining to a sequence. You can access this screen by selecting Feature Data from the
PatentIn 3.0 Application Steps Menu (Figure 4-1). The features that are displayed apply to the
sequence that is currently selected on the Sequence screen.

 Figure 6-1: PatentIn 3.0 Features Screen
To enter information about a Feature:
1. � Check the Join All CDSs box if the sequence contains more than one CDS and the CDSs

are to be joined.
2. � Click on the Names button to access the list of Nucleotide Names for

Feature Name / Key. For more information, see section 7.1.1.
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3. � Enter the “Relevant Residue From” and “To” sequence position numbers.
4. � Click in the Other Information box to provide other information. This is where you

document X in a protein sequence or n in a base sequence.
5. To clear the Edit Feature portion of the screen � Click on the Clear button.
6. To insert an entry from the Feature List, highlight it and � click on the Insert button.
7. To replace an entry from the Feature List, highlight it and � click on the Replace button.
8. To delete an entry from the Feature List, highlight it and � click on the Delete button.
9. To validate the information entered, � click on Validate. Data entered in the table (Insert) is

then validated. Information in the edit area, that has not yet been inserted, is not validated.
10. To save the information, � click on the Save Project button.
11. To validate and close, � click on the OK button.
12. To cancel the information, � click on the Cancel button.
13. To access the help information,� click on the Help button.
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6.1.1 Feature Key Selection

The Feature Key Selection Screen (Figure 6-2) allows the user to select a Nucleotide name.

Figure 6-2: Feature Key Selection Screen
To select a Nucleotide name:
1. � Select the Names button on the PatentIn 3.0 Features Screen( Figure 6-1).
2. � Click on the down arrow to open the drop-down list.
3. � Click on the name.
4. � Click on OK to accept the selection and return to the PatentIn 3.0 Features Screen

( Figure 6-1).
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SECTION 7
PUBLICATION DATA

7.1 PATENTIN 3.0 PUBLICATION TYPE SCREEN

The PatentIn 3.0 Publication Type Screen (Figure 7-1) provides access to four screens for
entering publication information. They are Journal, Database, Patent, and Thesis. You can access
this screen by selecting Publication Data from the Application Steps menu.

Figure 7-1: PatentIn 3.0 Publication Type Screen
To select a Publications Type:
1. From the pull down menu, Application Steps, � Click on Publication Data.
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7.2 PATENTIN 3.0 JOURNAL PUBLICATION INFORMATION

 The PatentIn 3.0 Journal Publication Information Screen ( Figure 7-2) provides the user with a
means to input published supporting scientific literature with the patent application.

 Figure 7-2: PatentIn 3.0 Journal Publication Information Screen
To enter information about a Journal Publication:
1. From the Application Steps menu, � select Publication Data,� select Journal.
2. � Enter the Database Name / Accession Number.
3. � Enter the Database Entry Date.
4. � Enter the name of the Author(s).
5. � Enter the Publication Title.
6. � Select the Journal name from the drop-down pick list. If the name is not on the list you

may � enter it.
7. � Enter the Volume.
8. � Enter the Issue.



7-4

9. � Enter the Publication Date.
10. � Enter the Page Ranges.
11. In the � Enter the “Relevant Residue From” and “To” sequence position numbers.
12. � Click on the Clear button to clear the Journal Publications portion of the screen.
13. To insert an entry from the  Journal List, highlight it and � click on the Insert button.
14. To replace an entry from the Journal List, highlight it and � click on the Remove button.
15. To delete an entry from the Journal List, highlight it and � click on the Delete button.
16. To validate the information entered, � click on Validate. Data entered in the table (Insert) is

then validated. Information in the Journal Publications edit area, that has not yet been
inserted, is not validated.

17. To save the information, � click on the Save Project button.
18. To validate and close, � click on the OK button.
19. To proceed to the next Publication Data, Database, � click on the To Databases���� button.
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7.3 PATENTIN 3.0 DATABASE PUBLICATION INFORMATION

The PatentIn 3.0 Database Publication Information Screen ( Figure 7-3) provides the user with a
means to input published supporting scientific database with the patent application.

 Figure 7-3: PatentIn 3.0 Database Publication Information Screen
To enter information about a Database Publication:
1. From the Application Steps � select  Publications Data, then � select Database.
2. � Enter the Database Name / Accession Number.
3. � Enter the Database Entry Date.
4. � Enter the “Relevant Residues From” and “To” sequence position numbers.
5. � Click on the Clear button to clear the Databases part of the screen.
6. To insert an entry into the Patent List, highlight it and � click on the Insert button.
7. To replace an entry from the Patent List, highlight it and � click on the Remove button.
8. To delete an entry from the Patent List, highlight it and � click on the Delete button.
9. To validate the information entered, � click on Validate. Data entered in the table (Insert) is

then validated. Information in the edit area, that has not yet been inserted, is not validated.
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10. To save the information, � click on the Save Project button.
11. To validate and close, � click on the OK button.
12. To go back to the previous Publication Data, Journal, � click on the ���� To Journals

button.
13. To proceed to the next Publication Data, Patent,� click on the To Patents���� button.

7.4 PATENTIN 3.0 PATENT PUBLICATIONS INFORMATION

The PatentIn 3.0 Patent Publication Information Screen ( Figure 7-4) provides the user with a
means to input published supporting patent publication information with the patent application.

 Figure 7-4: PatentIn 3.0 Patent Publication Information Screen
To enter information about a Patent Publication:
1. From the Application Steps � select Publications Data, then � select Patent.
2. � Enter the Database Name / Accession Number.
3. � Enter the Database Entry Date.
4. � Enter the Document Number.
5. � Enter the Filing Date.
6. � Enter the Publication Date.
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7. � Enter the Title.
8. � Enter the “Relevant Resides From” and “To” sequence position numbers.
9. � Click on the Clear  button to clear the Patents portion of the screen.
10. To insert an entry into the Patent List, highlight it and � click on the Insert button.
11. To replace an entry from the Patent List, highlight it and � click on the Replace button.
12. To delete an entry from the Patent List, highlight it and � click on the Delete button.
13. To validate the information entered, � click on Validate. Data entered in the table (Insert) is

then validated. Information in the edit area, that has not yet been inserted, is not validated.
14. To save the information, � click on the Save Project button.
15. To validate and close, � click on the OK button.
16. To go back to the previous Publication Data, Database, � click on the ���� To Databases

button.
17. To proceed to the next Publication Data, Thesis, � click on the To Theses���� button.
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7.5 PATENTIN 3.0 THESIS PUBLICATION INFORMATION

The PatentIn 3.0 Thesis Publications Information Screen (Figure 7-5) provides the user with a
means to input published supporting thesis publication information with the patent application.

Figure 7-5: PatentIn 3.0 Thesis Publications Information Screen
To enter information about a Thesis Publication:
1. From the Application Steps � select Publications Data, � select Thesis.
2. � Enter the Database Name / Accession Number.
3. � Enter the Database Entry Date.
4. � Enter the Author Name.
5. � Enter the Title.
6. � Enter the Publication Date.
7. � Enter the Page Ranges.
8. � Enter the “Relevant Residues From” and “To” sequence position numbers.
9. � Click on the Clear  button to clear the Theses portion of the screen.
10. To insert an entry into the Thesis List, highlight it and � click on the Insert button.
11. To replace an entry from the Thesis List, highlight it and � click on the Replace button.



7-9

12. To delete an entry from the Thesis List, highlight it and � click on the Delete button.
13. To validate the information entered, � click on Validate. Data entered in the table (Insert) is

then validated. Information in the edit area, that has not yet been inserted, is not validated.
14. To save the information, � click on the Save Project button.
15. To validate and close, � click on the OK button.
16. To go back to the previous Publication Data, Patent, � click on the ����To Patents button.

ii NOTE: FOR THE PUBLICATION DATA, VALIDATION IS DONE ON ALL OF THE INSERTED DATA.
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SECTION 8
CREATING A SEQUENCE LISTING FILE

8.1 SEQUENCE LISTING FILE

The sequence listing file includes all the information required by the ST.25 standard. PatentIn
3.0 generates a sequence listing file names “ST25.txt, and places it in the directory containing the
project.

8.2 GENERATING A SEQUENCE LISTING FILE

The PatentIn 3.0 Sequence Generation  Screen (Figure 8-1) notifies the user that the Generate
process is about to occur and gives the option to be notified if any errors occur during the
process.

Figure 8-1: PatentIn 3.0 Sequence Generation Screen
To Generate a Sequence Listing:
1. � Select Generate Sequence Listing from the Application Steps menu (Figure 4-1).
2. � Click in the box next to “Pause after each error message” if you wish to be notified of an

error in the sequence data.
3. � Click on the Start the sequence generation.
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Figure 8-2:  Second Sequence Generation Screen
4. � Click on the Continue button to continue validation.
5. � Click  on the Cancel button to cancel validation.
6. If an error message is displayed and Pause was selected, an error message will appear and

validation will pause.
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8.3 VIEWING A SEQUENCE LISTING FILE

To view a Sequence Listing Project File:
1. If sequence generation succeeded and View listing or error log when done was selected, the

sequence listing will be shown automatically. If View listing or error log when done was
not selected you can view the sequence by selecting View Sequence Listing from the
Project menu.

Figure 8-3: View Results Window

ii   SPECIAL NOTE FOR USERS WITH VERY LARGE SEQUENCES AND LARGE NUMBERS OF SEQUENCES:  PTO has
located a viewer that really works for very large text files.  A 60 day evaluation version is
downloadable at www.fileviewer.com <http://www.fileviewer.com> .  The viewer is named "V"
and version 2000 SR-1.  It was tested with 60MB and 120MB files and “worked great.” It should
manage files of almost any size.  It was tested on a laptop with Win98. (LocalAdmin may be
required for installation.)
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8.4 COPYING THE SEQUENCE LISTING TO A DISK

The PatentIn 3.0 Copy to Disk Screen (Figure 8-4) provides the user with the means to name: the
drive name to where the file is to be copied, the filename for the copied file and the type of the
copied file.

Figure 8-4: PatentIn 3.0 Copy to Disk Screen
To copy a sequence listing:
1. � Select Copy to Disk from the Application Steps menu (Figure 4-1).
2. � Enter the drive name (Figure 8-4) in the Save in field.
3. � Enter the File name in the File name field.
4. � Select the type .txt or .zip in the Save in: field.
5. � Click on Save to submit the application.
If .txt is selected, PatentIn checks to see if there is enough free disk space to receive the listing
file.  If so, the file will be copied to the selected location.  If not, PatentIn will suggest .zip.

ii NOTE: .ZIP WORKS ONLY WITH FLOPPY DISK AND WILL FORMAT THE DISK BEFORE WRITING
ANYTHING TO THE DISK.
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APPENDIX A
LIST OF ACRONYMS

MB Megabytes

MHz Megahertz

PC Personal Computer

URL Universal Resource Locator

USPTO United States Patent and Trademark Office

WIPO World Intellectual Property Organization

WPI Web PatentIn

WWW World Wide Web
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APPENDIX B
FIELD IDENTIFIERS, LENGTHS AND TYPES

Table B-1, below, includes a complete list of all field names that appear in the data entry screens,
and corresponding field identifiers, field lengths, and field types. Field identifiers are used to
separate WPI data into raw data files, and Sequence Listing Project Files.

Table B-1:  Field Name, Identifier, Size, and Type
Field

Identifier
Field Name Field Length Field Type

A-alpha N- numeric

N/A Project Name 8 AN

<110> Applicant Name 1200 AN

<120> Title of Invention 240 AN

<130> File Reference 60 AN

<140> Current Application Number 23 AN

<141> Current Filing Date 8 N

<150> Earlier Application Number 23 AN

<151> Earlier Filing Date 8 N

N/A Sequence File Name 8 AN

<160> Number of Sequences 5 N

<170> Software 60 AN

<210> Information for SEQ ID No. 5 N

<211> Length 6 N

<212> Type 3 A

<213> Organism 60 AN

<220> Feature 0 B

<221> Name/key 20 AN

<222> Location 12 N

<223> Other Information 260 AN

<300> Publication Information 0 B

<301> Authors 120 AN

<302> Title (of Publication) 120 AN

<303> Journal (name) 40 AN
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<304> Volume 5 AN

<305> Issue 5 AN

<306> Pages 20 AN

<307> Date 30 AN

<308> Database Accession Number 45 AN

<309> Database Entry Date 8 N

<310> Document number 18 AN

<311> Filing Date 8 N

<312> Publication Date 8 N

<313> Relevant Residues 20 N

<400> Sequence Description 100,000 AN
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APPENDIX C
COUNTRY CODES

Table C-1 includes a complete list of country codes that are used when completing the Current
Application Number field in the PatentIn 3.0 Project Data Screen (Figure 4-2) and the Prior
Application Number field in the PatentIn 3.0 Prior Application Information Screen(Figure
4-3).

Table C-1:  Country Codes

Code Country

AF Afghanistan

OA African Intellectual Property Organization (OAPI)

AP African Regional Industrial Property Organization (ARIPO)

AL Albania

DZ Algeria

AO Angola

AI Anguilla

AG Antigua & Barbuda

AR Argentina

AU Australia

AT Austria

BS Bahamas

BH Bahrain

BD Bangladesh

BB Barbados

BE Belgium

BZ Belize

BX Benelux Trademark Office and Benelux Designs Office

BJ Benin

BM Bermuda

BT Bhutan

BO Bolivia
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Code Country

BW Botswana

BR Brazil

VG British Virgin Islands

BN Brunei Darussalam

BG Bulgaria

BF Burkina Faso

BU Burma

BI Burundi

CM Cameroon

CA Canada

CV Cape Verde

KY Cayman Islands

CF Central African Republic

TD Chad

CL Chile

CN China

CO Columbia

KM Comoros

CG Congo

CR Costa Rica

CI Cote d'Ivoire

CU Cuba

CY Cyprus

CS Czechoslovakia

KH Democratic Kampuchea

KP Democratic People's Republic of Korea

YD Democratic Yemen

DK Denmark

DJ Djibouti
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Code Country

DM Dominica

DO Dominican Republic

EC Ecuador

EG Egypt

SV El Salvador

GQ Equatorial Guinea

ET Ethiopia

EP European Patent Office (EPO)

FK Falkland Islands (Malvinas)

FJ Fiji

FI Finland

FR France

GA Gabon

GM Gambia

DD German Democratic Republic

DE Germany, Federal Republic of

GH Ghana

GI Gibraltar

GR Greece

GD Grenada

GT Guatemala

GN Guinea

GW Guinea-Bissau

GY Guyana

HT Haiti

VA Holy See

HN Honduras

HK Hong Kong

HU Hungary
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Code Country

IS Iceland

IN India

ID Indonesia

IR Iran (Islamic Republic of)

IQ Iraq

IE Ireland

IL Israel

IT Italy

JM Jamaica

JP Japan

JO Jordan

KE Kenya

KI Kiribati

KW Kuwait

LA Laos

LB Lebanon

LS Lesotho

LR Liberia

LY Libya

LI Liechtenstein

LU Luxembourg

MG Madagascar

MW Malawi

MY Malaysia

MV Maldives

ML Mali

MT Malta

MR Mauritania

MU Mauritius
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Code Country

MX Mexico

MC Monaco

MN Mongolia

MS Montserrat

MA Morocco

MZ Mozambique

NR Nauru

NP Nepal

NL Netherlands

AN Netherlands Antilles

NZ New Zealand

NI Nicaragua

NE Niger

NG Nigeria

NO Norway

OM Oman

PK Pakistan

PA Panama

PG Papua New Guinea

PY Paraguay

PE Peru

PH Philippines

PL Poland

PT Portugal

QA Qatar

KR Republic of Korea

RO Romania

RW Rwanda

KN Saint Christopher & Nevis
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Code Country

SH Saint Helena

LC Saint Lucia

VC Saint Vincent & the Grenadines

WS Samoa

SM San Marino

ST Sao Tome & Principe

SA Saudi Arabia

SN Senegal

SC Seychelles

SL Sierra Leone

SG Singapore

SB Solomon Islands

SO Somalia

ZA South Africa

SU Soviet Union

ES Spain

LK Sri Lanka

SD Sudan

SR Suriname

SZ Swaziland

SE Sweden

CH Switzerland

SY Syria

TW Taiwan, Province of China

TH Thailand

TG Togo

TO Tonga

TT Trinidad & Tobago

TN Tunisia
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Code Country

TR Turkey

TV Tuvalu

UG Uganda

AE United Arab Emirates

GB United Kingdom

TZ United Republic of Tanzania

US United States of America

UY Uruguay

VU Vanuatu

VE Venezuela

VN Viet Nam

WO World Intellectual Property Organization (WIPO)

YE Yemen

YU Yugoslavia

ZR Zaire

ZM Zambia

ZW Zimbabwe
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APPENDIX D
TABLE TO EXCHANGE NUCLEOTIDE CHARACTERS AND AMINO

CHARACTERS

Table D-1 provides a list of acceptable characters to be used for hand keying PRT/1 data into the
sequence description field, importing PRT/3 data, and converting PRT/1 data in the sequence
description field.  The nucleotide equivalent data is utilized during sequence listing project file
generation when all CDS featured codons (three letter nucleotides) are translated into an amino
abbreviated name (PRT/3).

Table D-1:  Exchange Nucleotide Characters and Amino Characters

PRT/1 PRT/3 Nucleotide Equivalent

A Ala gcu, gcc, gca, gcg, gct

R Arg cgu, cgc, cga, cgg, cgt, aga,
agg

N Asn aau, aac, aat

D Asp gau, gac, gat

B Asx

C Cys ugu, ugc, tgt, tgc

Q Gln caa, cag

E Glu gaa, gag

Z Glx

G Gly ggu, ggc, gga, ggg, ggt

H His cau, cac, cat

I Ile auu, auc, aua, att, atc, ata

L Leu uua, uug, cuu, cuc, cua, cug,
tta, ttg, ctt, ctc, cta, ctg

K Lys aaa, aag

M Met aug, atg

F Phe uuu, ucc, ttt, ttc

P Pro ccu, ccc, cca, ccg, cct

S Ser ucu, ucc, uca, ucg, tct, tcc,
tca, tcg, agu, agc, agt

T Thr acu, acc, aca, acg, act
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PRT/1 PRT/3 Nucleotide Equivalent

W Trp ugg, tgg

Y Tyr uau, uac, tat, tac

V Val guu, guc, gua, gug, gtt, gtc,
gta, gtg

X Xaa any set containing “n”
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APPENDIX E
NUCLEOTIDE SEQUENCE FEATURES

Table E-1 provides a list (in alphanumeric order) of Nucleotide sequence features that are
displayed in the PatentIn 3.0 Features Screen when you have previously selected DNA or RNA
as the Sequence Type and � clicked on the Names button.  A list of nucleotides appears in a
pick list after � clicking on the down arrow at the end of the Nucleotide box.  After � clicking
on a sequence feature in the pick list, the sequence feature name appears in the
Feature Name / Key field (<221>).

Table E-1:  Nucleotide Sequence Features

Nucleotide Sequence Features

-10_signal

3’clip

3’UTR

-35_signal

5’clip

5’UTR

Allele

Attenuator

C_region

CAAT_signal

CDS

Conflict

D-loop

D-segment

Enhancer

Exon

GC_signal

Gene

IDNA

Intron

J_segment
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Nucleotide Sequence Features

LTR

Mat_peptide
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APPENDIX F
AMINO ACID SEQUENCE FEATURES

Table F-1 provides a list (in alphabetical order) of AminoAcids sequence features that are
displayed in the PatentIn 3.0 Features Screen when you have previously selected PRT as the
Sequence Type and� clicked on the Names button. The listed sequence features appear in a
pick list after � clicking on the down arrow at the end of the AminoAcids box.  After �
clicking on a sequence feature in the pick list, the sequence feature name appears in the
Feature Name / Key field.

Table F-1:  Amino Acid Sequence Features

Amino Acid Sequence Features
ACT_SITE

BINDING

CA_BIND

CARBOHYD

CHAIN

CONFLICT

DISULID

DNA_BIND

DOMAIN

HELIX

INIT_MET

LIPID

METAL

MOD_RES

MUTAGEN

NON_CONS

NON_TER

NP_BIND

PEPTIDE

PROPEP

REPEAT

SIGNAL
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Amino Acid Sequence Features
SIMILAR

SITE

STRAND

THIOETH

THIOLEST

TRANSIT

TRANSMEM

TURN

UNSURE

VARIANT

VARSPLIC

ZN_FING
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APPENDIX G
DATA TABLES FOR MOD_RES SEQUENCE FEATURES

Appendix G provides a list (in alphabetical order) of additional modified residue (MOD_RES)
Sequence Features that are displayed in the PatentIn 3.0 Features Screen when you have
previously selected PRT as the Sequence Type, and MOD_RES from the listed sequence
features in the pick list.  After � clicking on a sequence feature in the pick list, MOD_RES
appears in the Feature Name / Key field (<221>), and the first Add the following MOD-RES
to the Other Information field for MOD_RES (Table G-1) and second Add the following
MOD-RES to the Other Information field for MOD_RES (Table G-2) sequence features
appears. You can � select from either one or both of the Add the following MOD-RES to the
Other Information fields, and the data will appear in the Other Information field (<223>).

Table G-1:  First Data Table for MOD_RES Sequence Features

First Data Table for MOD_RES Sequence Features

Blank space (default option)

ACETYLATION

AMIDATION

BLOCKED

FORMYLATION

GAMMA-CARBOXYGLUTAMIC ACID HYDROXYLATION

METHYLATION

PHOSPHORYLATION

PYRROLIDONE CARBOXYLIC ACID

SULFATATION

Table G-2:  Second Data Table for MOD_RES Sequence Features

Second Data Table for MOD_RES Sequence Features

Symbol Meaning

Blank space (default option)

Aad 2-Aminoadipic acid

Baad 3-Aminoadipic acid

Bala beta-Alanine, beta-Aminopropionic acid

Abu 2-Aminobutyric acid
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Second Data Table for MOD_RES Sequence Features

Symbol Meaning

4Abu 4-Aminobutyric acid, piperidinic acid

Acp 6-Aminocaproic acid

Ahe 2-Aminoheptanoic acid

Aib 2-Aminoisobutyric acid

BAib 3-Aminoisobutyric acid

Apm 2-Aminopimelic acid

Dbu 2,4 Diaminobutyric acid

Des Desmosine

Dpm 2,2’-Diaminopimelic acid

Dpr 2,3-Diaminopropionic acid

EtGly N-Ethylglycine

EtAsn N-Ethylasparagine

Hyl Hydroxylysine

AHyl allo-Hydroxylysine

3Hyp 3-Hydroxyproline

4Hyp 4-Hydroxyproline

Ide Isodesmosine

Alle allo-Isoleucine

MeGly N-Methylglycine, sarcosine

Melle N-Methylisoleucine

MeLys 6-N-Methyllysine

MeVal N-Methylvaline

Nle Norleucine

Nva Norvaline

Orn Ornithine
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APPENDIX H
ADDITIONAL LIPID SEQUENCE FEATURES

Table H-1 provides a list (in alphabetical order) of additional lipid sequence features that are
displayed in the PatentIn 3.0 Features Screen when you have previously selected PRT as the
Sequence Type, and LIPID from the listed sequence features in the pick list.  After � clicking
on a Sequence Feature in the Sequence Feature Pick List, lipid appears in the
Feature Name / Key field (<221>) and the Add the following LIPID to the Other
Information field appears.  When you select from the Add the following LIPID to the Other
Information field, the data appears in the Other Information field (<223>).

Table H-1:  Additional Lipid Sequence Features

Additional Lipid Sequence Features

FRAMESYL

GERANYL-GERANYL

GPI-ANCHOR

MYRISTATE

N-ACYL DIGLYCERIDE

PALMITATE
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APPENDIX I
ACCEPTABLE CHARACTERS IN THE SEQUENCE DESCRIPTION

FIELD

Table I-1 provides an acceptable list of characters used as a filter for hand keying or importing
DNA or RNA data into the sequence description field.  PRT/1 and PRT/3 data lists are used
during sequence listing project file generation when all single letter protein data is translated into
amino abbreviated name (PRT/3) data.

Table I-1:  Acceptable Characters in the Sequence Description Field
DNA RNA DNA/RNA Protein/1 Protein/3

A A A A Ala

G G G C Cys

C C C D Asp

T T E Glu

U U F Phe

R R R G Gly

Y Y Y H His

M M M I Ile

K K K K Lys

S S S L Leu

W W W M Met

B B B N Asn

D D D P Pro

H H H Q Gln

V V V R Arg

N N N S Ser

T Thr

V Val

W Trp

Y Tyr

B Asx

Z Glx

X Xaa
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APPENDIX J
ADDITIONAL MODIFIED_BASE SEQUENCE FEATURES

Table J-1 provides a list (in alphabetical order) of additional modified_base sequence features
that are displayed in the PatentIn 3.0 Features Screen when you have previously selected DNA or
RNA as the Sequence Type, and modified_base from the listed sequence features in the pick
list.  After � clicking on a sequence feature in the list, modified_base appears in the
Feature Name / Key field (<221>), and the Add the following Modified_base to the Other
Information field appears in the PatentIn 3.0 Features Screen.  The user selects from the pick
lists, and the data appears in the Other Information field (<223>).

Table J-1:  Modified_base Sequence Features

Symbol Meaning

ac4c 4-acetylcytidine

chm5u 5-(carboxyhydroxymethyl)uridine

cm 2’-o-methylcytidine

cmnm5s2u 5-carboxymethylaminomethyl-2-thiouridine

cmnm5u 5-carboxymethylaminomethyluridine

d dihydrouridine

fm 2’-O-methylpseudouridine

gal q Beta, D-galactosylquesosine

gm 2’-O-methylguanosine

i inosine

i6a N6-isopentenyladenosine

m1a 1-methyladenosine

m1f 1-methylpseudouridine

m1g 1-methylguanosine

m1i 1-methylinosine

m22g 2,2,-dimethylguanosine

m2a 2-methyladenosine

m2g 2-methylguanosine

m3c 3-methylcytidine

m5c 5-methylcytidine
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Symbol Meaning

m6a N6-methyladenosine

m7g 7-methylguanosine

mam5u 5-methylaminothyluridine

mam5s2u 5-methyloxyaminomethyl-2-thiouridine

man q beta, D-mannosylqueosine

mcm5s2u 5-methyloxycarbonylmethyl-2-thiouridine

mcm5u 5-methyloxycarbonylmethyluridine

mo5u 5-methyloxyuridine

ms2i6a 2-methylthio-N6-isopentenyladenosine

ms2t6a N-((9-beta-D-ribofuranosyl-2-methylthiopurine-6-yl)
carbamoyl)threonine

mt6a N-((9-beta-D-ribofuranosylpurine-6-yl)-methylcarbamoyl)threonine

mv uridine-5-oxyacetic acid-methylester

o5u uridine-5-oxyacetic acid (v)

osyw wybutoxosine

p pseudouridine

q queosine

s2c 2-thiocytidine

s2t 5-methyl-2-thiouridine

s2u 2-thiouridine

s4u 4-thiouridine

t 5-methlyuridine

t6a N-((9-beta-D-ribofuranosylpurine-6-yl)-carbamoyl)threonine

Tm 2’-O-methyl-5-methyluridine

Um 2’-O-methyluridine

Yw wybutosine

X 3-(3-amino-3-carboxy-propyl)uridine, (acp3)u


